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1 Introduction

Thank you for purchasing your Vi-PEC Plug-In Engine Control Unit (ECU).  Vi-PEC VX ECUs
are an advanced, fully programmable microprocessor controlled Engine Management
System.  

The VX software platform boasts an impressive list of features giving a new level of user
adjustment.  This flexibility allows the tuner to have complete control over the engine
management system.   VX software employs high resolution fuel and ignition tables with
configurable load and RPM centres.  When coupled with up to six dimensional fuel and
ignition mapping, barometric pressure compensation and intake air temperature correction
this gives an unprecedented level of tuning accuracy.  All Vi-PEC VX ECUs are in field
upgradeable, there is no need to return the unit for software updates.

All Vi-PEC VX Plug-In Engine Management Systems are designed with flexibility and ease of
installation in mind.  Vi-PEC Plug-In systems are deigned to replace the circuit board inside
the factory ECU enclosure.  This provides an invisible install that requires minimal
modification to vehicle wiring and ECU mounting.

Vi-PEC Engine Management Systems are designed with the final result in mind.  Not only do
they boast an impressive range of performance features, but are designed with a focus on
safety, reliability and drive-ability.  However, the ultimate success of your engine management
upgrade is determined by how well the system is installed and tuned.

Installing and tuning any after market engine management system is not to be taken lightly. 
VX ECUs give the tuner the control & flexibility that only top after-market engine management
systems in the world can provide.  While every effort has been made to keep VX ECUs as
user friendly as possible, it should be recognised that added features bring added complexity.

The complete setup of your ECU can be divided into two  important tasks:

1. This manual covers the installation of your VX ECU.  While it is not strictly essential that
this work is performed by an automotive electrician, the knowledge and tools available to
these professionals makes it highly recommended. Regardless of who does  the
installation, it is of utmost importance that instructions provided in this manual are followed
exactly throughout the installation.

2. Once the VX ECU has been installed it will need to be tuned using a laptop computer with
Vi-PEC Tuning Software software.  Information on the configuration and tuning of the VX
ECU is detailed in the online help section of Vi-PEC Tuning Software.  VX ECUs are
shipped pre-loaded with a base  configuration that should be close enough to get most
engines running after a few application specific adjustments have been made.  While
hearing the engine running on the new ECU for the first time is always a satisfying feeling,
it is important to realise that the job is not complete.  The amount of tuning performed and
the experience of the tuner are the two most important factors in determining how happy
you will be with your engine management system.

1.1 Safety Notice

Your Vi-PEC Plug-In ECU is designed to enhance the performance of your vehicle.  However
in all cases, your vehicle must be operated in a safe manner.  Do not tune your vehicle while
operating it on public roads.  Obey road rules at all times.
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WARNING!

Failure to follow all installation and operating instructions may result in
damage to the Vi-PEC ECU, personal injury, or harm to property.

1.2 Disclaimer

All care has been taken to ensure the pin outs and interconnections of the ECU to the
vehicles wiring harness are correct.  However due to variations between vehicle models it is
the installers responsibility to check wiring connections BEFORE installing the ECU.  Vi-PEC
will not be held responsible for any damage caused by the incorrect installation of this
product.

1.3 Support Options

Should any issues arise during installation, the following options exist for technical support:

1. Vi-PEC Tuning Software help, press F1 while running Vi-PEC Tuning Software

2. Contact your nearest Vi-PEC dealer.  A Vi-PEC dealer list is available on our website.

3. Vi-PEC website:  www.ViPEC.com

4. Technical Support Email:  tech@ViPEC.com

5. Online Discussion Board: Available from the Vi-PEC website.

The majority of questions received by the technical support team are  clearly answered in the
manuals.  To speed up your technical inquiry please consult the manuals to make sure that
your question has not already been answered.
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2 Pre-Installation

Before installing theVi-PEC VX ECU into the vehicle some pre-installation checks must be
performed. 

2.1 Board Switch Settings

Some Vi-PEC VX ECUs require switches on the board to be set before installation.

2.1.1 Nissan Silvia/180SX/200SX SR Short Header ECU

Some models are wired with their trigger (engine position) signals wired in opposite polarity to
other models. To allow for this four dip switches have been provided on the ECU.

Set the DIP switches according to the diagram below:

If your ECU bottom board is version 1.2 or higher, you will have a second set of jumpers. The
jumpers are used to configure the board for either a 1991 - 1993 or a 1994 - 2002 SR20DET.

Warning: Confirm the vehicles pinout against the information provided in the rear of this
manual before configuring and installing the ECU.

The rectangles represent the orientation of the jumpers.

For a 1991 - 1993 SR20DET use six jumpers in the vertical direction as indicated in the
diagram. Notice the two dots, no jumper will be fitted here.

For a 1994 - 2002 SR20DET use seven jumpers in the horizontal direction as indicated
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in the diagram. There are no dots, the jumpers will cover all pins

2.2 Injector Impedance

Injector impedance is important and needs consideration before installing the ECU.

2.2.1 Nissan Silvia/180SX/200SX SR Short Header ECU

The Nissan VX Short Header VX Plug-In ECU is NOT designed to be used directly
with low impedance injectors.

GTiR models are fitted with LOW impedance injectors run via factory fitted ballast resistors.
This ECU has been designed to be used with HIGH impedance (greater than 6 Ohms)
injectors. Ballast resistors must be wired if low impedance injectors are to be used. This
means that the ECU is plug-in compatible with factory fitted injector/ballast combinations on
all models. However if fitting low impedance injectors (e.g. fitting GTiR injectors) then ballast
resistors must be wired. Contact your nearest Vi-PEC dealer to purchase a ballast resistor
pack if required.
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3 Installation

This guide provides information on correctly and safely installing your new Vi-PEC VX Plug-In
ECU.

3.1 ECU Handling Procedures

WARNING!!!

The following installation process will require handling of both the Vi-
PEC ECU and factory ECU. Both of these are highly sensitive to

electrostatic discharge and are easily damaged. Follow the anti-static
precautions given in this manual carefully to avoid damaging

electronic components. Warranty claims for ECUs damaged by
electrostatic discharge will NOT be accepted.

ANTI-STATIC HANDLING GUIDELINES

Your body builds up an electrical charge as you move around. This charge can
reach very high voltages. Whenever given the opportunity this energy will attempt

to discharge (usually through your finger tips!). This can be fatal to most
electronic components. Most people have experienced an electrostatic
discharge when they step out of their car or touch a metal bench top. 

1. The following guidelines describe precautions that can be taken to reduce the
possibility of damaging your ECU:

2. Work only on a conductive surface. A clean steel bench is suitable.

3. Always wear a wrist strap that is electrically connected to the conductive
working surface.

4. Touch the working surface regularly.

5. Do NOT touch components on the circuit board.

6. Where possible, only handle the ECU by its plastic header.

7. Do NOT carry the ECU around without anti-static packaging. 

8. Do NOT touch the bare terminals in the ECU header.

Observing the above procedures will minimise the chance of damaging the ECU.
Note that failure due to static damage often does not appear until well after it was

caused.
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3.2 Fitting the ECU

Information is provided to assist in fitting the ECU into the vehicle.

3.2.1 Fitting a Nissan ECU

The following steps outline the installation procedure:

1. Remove the factory ECU from the vehicle: Ensure the key is in the OFF position. The
factory ECU is located on the left side A pillar. Remove the left kick panel. Unplug the wiring
harness from the factory ECU (use a 10mm socket to unwind the connector while gently
pulling on it). Remove the 6mm bolts (10mm socket) that retain the ECU and remove the
ECU from the vehicle. DO NOT touch the exposed pins in the factory ECU connector.

2. Remove the factory ECUs circuit board from its enclosure: Ensure you are following the
given anti-static guidelines and ARE WEARING A CONDUCTIVE WRIST STRAP
connected to a conductive working surface. Remove the top and bottom covers from the
ECU enclosure by removing the four corner retaining screws. Remove the circuit board by
removing the retaining screws. Hold it only by the plastic header and place it aside.

3. Fit the Vi-PEC Plug-In ECU: Remove the ECU from its packaging and place it immediately
in the factory enclosure. Place the factory ECU in the packaging your Vi-PEC ECU came in
for its protection. It may be necessary to remove the screws that retain the blue header. 

4. Thread the USB tuning cable through the slot in the back of the case and plug it into the
ECU. You may need to unplug it from the ECUs top board to do this. If using the internal
MAP sensor (recommended for all applications requiring less than 1.5 bar of boost) run a
length of vacuum hose into the enclosure and connect it to the MAP sensors pressure port.
It is recommended to use a hose clamp or small cable tie on this hose.

5. Reassemble the enclosure and fit the ECU back to the vehicle.

6. Connect the ECU to the factory wiring loom. Carefully tighten the header bolt while
pressing the sides of the connector into the ECU. It is a common fault for this connector to
bend in the middle and make poor connection.

7. Do NOT attempt to start the vehicle. Proceed to read through the remaining sections of
this manual first.
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4 Additional Sensors

VX Plug-In ECUs offer various options for the installation of additional sensors and devices. 
As a minimum it is recommended that all ECUs are installed with a Manifold Absolute
Pressure (MAP) sensor and Intake Air Temperature (IAT) sensor.  These parts can be
purchased if required from your nearest Vi-PEC dealer. 

4.1 MAP Sensor

It is important that the pressure source for a MAP sensor be taken from a stable pressure
source after the throttle body.  It is common to 'T' into the fuel pressure regulators pressure
signal.  Do NOT share this signal with other devices such as boost gauges or blow off valves.

4.1.1 Nissan Silvia/180SX/200SX SR Short Header

The Vi-PEC VX Nissan SR Plug-In ECU supports several options for fitting of a MAP sensor.
Any one of the following options can be used:

1. Internal MAP Sensor – To ease installation the VX Nissan SR ECU is fitted with an internal
MAP sensor. This sensor is rated to 2.5 Bar absolute pressure (1.5 Bar of boost). The
internal MAP sensor is wired to An Volt 3.

2. MAP Sensor Wired Through AFM – To avoid running additional wires into the engine bay, a
MAP signal can be brought in through either of the AFM signal wires. The  AFM signal is
wired to An Volt 4. Refer to factory wiring manuals for AFM wiring connections. Make sure
the AFM can not be reconnected.

3. MAP Via Expansion Connector - The expansion connector provides power ground and
analogue channels for the connection of a MAP sensor.

Make sure that the correct An Volt channel has been selected as MAP sensor in Vi-PEC
Tuning Software and a MAP calibration has been performed before attempting to start the
vehicle.

4.2 IAT Sensor

It is highly recommended that an IAT sensor be fitted in all applications to provide an input for
correction of fuel and ignition based on the engines air charge temperature.

An IAT sensor should be fitted in the intake system in a location that accurately represents
intake temperature.  The most common location is just prior to the throttle body.  Installing in
the manifold is not recommended due to heat soak issues.  A fast response sensor must be
used in all forced induction applications.

4.2.1 Nissan Silvia/180SX/200SX SR Short Header

The Vi-PEC VX Nissan SR Plug-In ECU supports several options for fitting of a IAT sensor.
Either of the following options can be used:

1. IAT Through Main Header – An Temp 2 is wired to pin 15 of the main header.  This wire is
normally used for diagnostics.  Connect an IAT sensor between this wire and  pin 29. 
Refer to the back of this manual for header pin numbering.

2. IAT Through Expansion Connector - The expansion connector provides ground and
temperature channels for the connection of an IAT sensor.
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4.3 Expansion Connector

The expansion connector is provided to allow easy connection of additional ECU inputs. An
“expansion cable” needs to be purchased from your Vi-PEC dealer. 

Important points when wiring to the expansion connector:

Do not overload the +5V Out pin. Although this is protected against ECU damage the +5V
out signal also provides power for other sensors.

Do not connect the ground pin to chassis ground. This could cause ground loops and
introduce unnecessary interference. Use this pin only to ground external sensors that are
isolated from chassis ground.

4.3.1 Nissan Silvia/180SX/200SX SR Short Header

The following expansion connector inputs/outputs are provided:

Gnd Sensor Ground Only 

+5V Out Low Current +5V Supply

DI6 Digital Input

An Volt 5 Analogue 0-5V input

An Volt 6 Analogue 0-5V input

An Temp 3 Temperature sensor input
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5 PC Tuning

VX ECUs require PC/laptop tuning using the Vi-PEC Tuning Software Tuning Software
application running on a Windows based computer.  Vi-PEC Tuning Software may be
downloaded from www.ViPEC.com. Note that when new versions of Vi-PEC Tuning Software
are released they are posted on the website and may be downloaded at no cost.  Also note
that VX ECUs must be used with the correct version of Vi-PEC Tuning Software.

IMPORTANT!

The VX ECU has on board USB.  

BEFORE connecting the ECU to your laptop, the USB drivers must
be installed.  Failure to install the drivers on your laptop first may

result in windows assigning incorrect drivers.  These drivers will not
work with the VX ECU and are difficult to uninstall.

5.1 Installing USB Drivers

Before connecting the ECU to your laptop or PC, the ECU USB drivers must be installed. 
These drivers are installed as part of Vi-PEC Tuning Software Tuning Software installation as
described in the following section.  Should internet download not be practical, a copy of the
drivers on CD can be obtained from your nearest Vi-PEC dealer.

5.2 Installing Vi-PEC Tuning Software Tuning Software

Due to the frequent updates Vi-PEC Tuning Software Tuning Software is no longer shipped
with each ECU.  You will be required to download the latest version of Vi-PEC Tuning
Software Tuning Software from: www.ViPEC.com

Should access to an Internet connection be impractical, the latest version of Vi-PEC Tuning
Software Tuning Software can be requested from your nearest Vi-PEC dealer on CD.

Installing from the web

1. Go to the above website and navigate to the downloads and software updates section.
2. Download the latest version of Vi-PEC Tuning Software.  When prompted to run or

save the file, select save.  It is recommended to save this file on the desktop.
3. Double click the saved file and follow on screen instructions.
4. When prompted to install USB drivers, select yes.  This may take some time.
5. When installed, open Vi-PEC Tuning Software by double clicking on the icon that has

been placed on the desktop.

Installing from a CD

1. Insert the Vi-PEC Tuning Software disk into you computer’s CD ROM drive.
2. Open 'My Computer'
3. Double click your CD ROM drive.
4. Double click the file labelled Vi-PEC Tuning SoftwareSetup.exe (or similar name).
5. Follow the on screen instructions.
6. When prompted to install USB drivers, select yes.  This may take some time.
7. When installed, open Vi-PEC Tuning Software by double clicking on the icon that has

been placed on the desktop.
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5.3 Communicating With Your ECU

After Vi-PEC Tuning Software installation, you will be able to connect  the VX ECU to the
laptop to perform set-up and tuning work.

1. Connect the ECU to your laptop using a Vi-PEC VX ECU USB Cable.  If not supplied
with the ECU, these can be purchased from a Vi-PEC dealer.  No other adapter or
cabling is required.  Connect the cable to the connector labelled USB.

2. If this is the first time you have connected a VX USB ECU to you laptop follow the
driver installation instructions that appear.  When prompted if you want to install
drivers select 'Continue Anyway'.

3. Start Vi-PEC Tuning Software by double clicking on the Vi-PEC Tuning Software icon
on the windows desktop.

4. Switch the key to the ON position.  This will provide power to the ECU.
5. In Vi-PEC Tuning Software, under the 'Options' menu, select 'Connection'.  The

connection options dialogue will open.  Select the correct COM Port number from the
drop down list or select auto for automatic com port detection.

6. Vi-PEC Tuning Software offers both mouse and keyboard control. To establish a
connection between the PC and ECU using the mouse, click the ‘L’ icon located near
the top centre of the Vi-PEC Tuning Software screen.   Alternatively, using the
keyboard, press and hold the Ctrl, Shift and L keys.  The same process can be used
to disconnect.  If a successful connection is established, Vi-PEC Tuning Software will
download settings from the ECU, otherwise you will be warned that an error has
occurred.

7. Make sure the connection shows “ONLINE” in the top right corner of Vi-PEC Tuning
Software.   The logo should also be spinning in the top right corner.  

8. To permanently STORE any changes made to the ECU click on the 'S' icon near the
top centre of the screen or press F4.  If this is not done before turning the ECUs
power off all changes made will be lost.
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6 Pre-Start Configuration

Before starting the vehicle, important pre-start configurations need to be made.

6.1 Firmware Version

It is recommended that the you Vi-PEC VX ECU is running the most up to date firmware.
Firmware version information can be obtained by connecting to the ECU with  Vi-PEC Tuning
Software and selecting 'ECU Information' under the Help menu.

The latest firmware can be downloaded from our website with Vi-PEC Tuning Software. 

It is recommended that this is performed by an experienced Vi-PEC dealer as new features
may need to be properly configured.

The firmware can be updated by selecting 'Update Firmware' under the 'ECU Controls' menu
in Vi-PEC Tuning Software. Follow the on screen instructions to complete the firmware
update process.

6.2 Base Configuration

All VX Plug-In ECUs are shipped with base configuration settings.   Note that these are
provided to reduce initial setup and tuning times.  They are NOT recommended tuning values.
 Vi-PEC Tuning Software includes base configurations for various models.  Download the
appropriate base configuration into your ECU with Vi-PEC Tuning Software by connecting to
the ECU (described in the Connecting To Vi-PEC Tuning Software section of this manual),
then selecting 'Open' under the 'File' menu.  Select the appropriate .pcl file and then select
'Open'.  Downloading large configuration files can take up to a few minutes.  Be patient and
acknowledge any messages Vi-PEC Tuning Software shows.

6.3 MAP Sensor Calibration

At key on and engine not running the Manifold Absolute Pressure (MAP) Sensor should
always match the Barometric Absolute Pressure (BAP) Sensor.  As well as providing altitude
correction, the BAP sensor also allows the MAP sensor to be calibrated prior to tuning.

Vi-PEC VX ECUs use an on-board barometric sensor that is calibrated prior to dispatch. 
This ensures that all Vi-PEC Tuning Software Tuning Software programs (pcl Files) give a
consistent state of tune throughout the ECU range.  This allows a PCL file to be transferred
between VX based ECUs giving an equivalent state of tune providing all factors affecting
volumetric efficiency are equal.

Without the ability to calibrate all the available types of MAP Sensors to the BAP Sensor there
would be significant affects on the accuracy of the resulting tune, especially when tuning with
Manifold Gauge Pressure (MGP) as a load index.

To calibrate the MAP sensor:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using Vi-PEC Tuning
Software.

2. Under the Analog Channels menu, select the An Volt channel that has been wired to the
MAP sensor.  Select the correct MAP Sensor Type.

3. Under the 'Options' menu, select 'MAP sensor calibration'.
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4. Follow the on screen instructions.

5. Select the 'Analog Inputs' tab in the runtime values section of Vi-PEC Tuning Software
(lower part of the screen).

6. Compare the MAP and BAP values and ensure they have a similar reading (within 1 kPa).

7. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.

6.4 TPS Calibration

The Throttle Position Sensor (TPS) is used by the ECU to calculate various engine
management parameters used by functions such as idle speed control,acceleration
enrichment and motor sport features.  It is important that the ECU knows when the throttle is
open and closed (or part way in between).  The following procedure calibrates the ECU to
match the TPS:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using Vi-PEC Tuning
Software.

2. Under the Analog Channels menu, ensure that An Volt 3 is set to 'TPS (Main)'.

3. Under the 'Options' menu, select 'TPS calibration'.

4. Follow the on screen instructions.

5. Select the 'Analog Inputs' tab in the runtime values section of Vi-PEC Tuning Software
(lower part of the screen).

6. Ensure the Throttle Position value reads 0% when the throttle is closed and 100% when
fully open.

7. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.

6.5 IAT Sensor Selection

This section only applies when an Intake Air Temperature (IAT) sensor has been wired and
fitted to the intake system.  It is important that the ECU is calibrated to match the sensor
installed in the engine. This procedure is as simple as selecting the correct sensor type as
follows:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using Vi-PEC Tuning
Software.

2. Click on 'Analogue Channel' in the configuration tree.

3. Select the An Temp channel the sensor has been wired to.

4. Ensure that channel (and only that channel) is set to 'Inlet Air Temperature'.

5. Select the correct 'Temp Sensor Type'.

6. Select the 'Analog Inputs' tab in the runtime values section of Vi-PEC Tuning Software
(lower part of the screen).

7. Ensure that IAT reads the correct temperature.

8. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.
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6.6 Ignition Mode Selection

Correct Ignition mode selection is essential for the vehicle to run properly.

6.6.1 Nissan Silvia/180SX/200SX

The Nissan Silvia/180SX/200SX VX Plug-In ECUs are designed to be used on multi-coil and
distributed ignition engines.  The type of ignition used will need to be configured before the
engine can be run. Do this by performing the following steps:

1. Connect a laptop/notebook PC to the ECU and connect to the ECU using Vi-PEC Tuning
Software.

2. Click on 'Ignition' in the configuration tree 

3. Select 'Ignition Setup'.

4. Set the 'Ignition Mode' to 'Distributed' or 'Direct Spark'.

5. Perform a 'Store' by clicking on the S button (top centre of screen) or press F4.

6.7 Input and Output Setup

As the Vi-PEC VX Plug-In ECUs are designed to run several models there are a few items
that must be set-up to make the ECU specific to your model. 

The Pin Functions section of this manual gives a list of the functions of each channel based
on the target vehicle.

It is the tuners responsibility to make sure that the following channels are set-up correctly for
the vehicle model the ECU is fitted to:

All Auxiliary Output Channels 

Use the 'Test On' or 'Test PWM' (at 10 Hz) functions to test the wiring of channels.

All Digital Inputs

Look at the Digital Inputs runtime values (lower section of the Vi-PEC Tuning Software
screen) to confirm each channels operation.

All Analogue Volt and Temperature Inputs

Look at the Analogue Inputs runtime values (lower section of the Vi-PEC Tuning Software
screen) to confirm each channels operation.

6.8 Trigger Calibration

The following instructions assume that all pre-start set-up instructions given in previous
sections have been completed.  Only after all pre-start checks have been made should an
attempt be made to crank the engine.  The following steps must be performed before an
attempt is made to start the engine to ensure the VX ECU is calibrated to precisely measure
engine position.

1. Connect the ECU to Vi-PEC Tuning Software.

2. Select 'Fuel', then 'Fuel Set-up':
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a. Set ‘Injection Mode’ to OFF.  This will prevent the engine from trying to start while the
triggers are calibrated.

b. Perform a Store (press F4) to make sure fuelling is not re-enabled if power to the ECU is
lost.

3. Click on ‘Triggers’ then ‘Calibrate Triggers’.

4. Perform the correct trigger calibration procedure specific to your vehicle as described in
the Vi-PEC Tuning Software Tuning Software online help (Press F1).

Note that trigger calibration must be performed again once the engine is running.  Due to the
acceleration and deceleration of the crankshaft at low speeds, an inaccurate measurement of
engine timing is usually made.  Also it is often harder to see timing marks with a timing light at
slow engine speeds.  Trigger calibration should be checked again at between 2000-4000
RPM where engine speed is stable and a more consistent timing reading can be obtained.
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7 First Time Startup

After performing all set-up instructions given in previous sections, including trigger calibration,
the engine is now ready to be started.  The following procedure should be used for first time
start-up.

1. Turn the ignition key OFF then ON.  The fuel pump should prime momentarily upon power
up.

2. Connect the ECU to Vi-PEC Tuning Software.

3. Click on each of the runtime value tabs (located about two thirds of the way down the
screen) and check that all values are as expected. Where possible operate sensors (e.g.
TPS) to ensure correct readings are displayed.  The following values should be checked:

a. TPS – spans from 0 to 100% when throttle is pressed.  If not, perform a TPS Calibration.

b. MAP – should read approx 101 kPa (at sea level) with the engine not running.  If not,
check the MAP Sensor Type setting and perform a MAP Calibration.

c. ECT – should read current engine temperature.

d. IAT – should read current intake air temperature.

e. Digital Inputs – Operate switches connected to any digital inputs while watching the
runtime value to ensure they operate as expected.

4. Rectify any faults found in Step 3.

5. Click on the ‘Fuel’ heading, then ‘Fuel Set-up’:

a. Locate the ‘Master’ setting.  This will need to be adjusted during or just after start-up.

6. Crank the engine until it starts.  Some throttle may be required for first time start-up due to
imperfect tuning.  If necessary adjust the Master setting to enrich/lean the engine (increase
to enrich).

7. If the engine fails to start after several attempts, do not crank it endlessly.  Stop and
determine the problem before continuing.

8. Check the Trigger Error Counter (found under the Triggers  runtime values tab).  If this
value increases during cranking/running then there is a trigger setup fault.  It is not unusual
for this number to count one or two on the first engine revolution.

9. Once the engine starts, adjust the ‘Master’ (under fuel settings) setting to achieve best
possible running.

10.The engine should now be allowed to fully warm up.  It may be necessary to readjust
‘Master’ several times to maintain smooth running.  Don’t forget to keep an eye on engine
temperature.

11.Once the engine is warmed up and running well, perform another trigger calibration
(known “as setting the base timing”).

12.Perform a Store by pressing F4.

7.1 Final Checks

To avoid potential engine damage and wasted time, the adjustments presented in the
following sections must be made before attempting to start the engine.  

For further help on any of the settings discussed below, consult the online Help in the Vi-PEC
Tuning Software Tuning Software.  Online help can be invoked by pressing F1, or right
clicking any item and selecting ‘What’s this?’.

Pre-set-up Checks

Before attempting to configure the ECU, ensure the following tasks have been completed:
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1. Ensure the ECU and all associated components are connected and correctly wired/
installed.  

2. Fully charge the vehicle’s battery, as the engine will be required to be cranked during
the set-up procedure.

3. Check all oil and water levels are correct.

Connecting to Vi-PEC Tuning Software Tuning Software

   Use the following procedure to establish a connection between your Vi-PEC ECU and Vi-
PEC Tuning Software Tuning Software tuning software.

1. Make sure your laptop battery is fully charged or plugged in to mains power.
2. Connect the ECU to your laptop and connect to Vi-PEC Tuning Software Tuning

Software as described in the 'Communicating with your ECU' section of this manual. 

7.2 Essential Tuning Adjustments

It is assumed that at this stage all set-up procedures described in previous sections have
been completed and the engine is running.  The following steps detail correct set-up
procedures for some of the more critical ECU parameters (note that MAP Sensor Calibration
should have already been completed by now):

Injector Voltage (Dead-time) Correction

There is always a delay between the injector being energised and the injector actually
opening.  Likewise, there is a small delay between the injector being de-energised and the
injector closing.  The opening time is considerably longer than the closing time, however the
overall result is that less fuel will flow for a given pulse width than would be expected with an
'ideal injector'.  To compensate for this the injector pulse widths are increased to compensate
for this 'dead-time'.  The dead-time for a given injector is a function of the battery voltage,
differential fuel pressure and the type of injector driver (saturated or peak and hold).  A typical
dead-time at 3 Bar differential fuel pressure and 14 volts is just under 1ms (ms = millisecond
= 1 thousandth of a second). 

In applications with a linear 1:1 fuel pressure regulator (i.e. not a rising rate regulator), the
differential fuel pressure (difference between manifold pressure and fuel pressure) will be
constant.  Therefore the only variable that is changing will be the battery voltage (this changes
with electrical load and sometimes engine speed).  Without correction, the changes in dead-
time will cause the engine to run lean when the voltage drops.  If the Injector Voltage
Correction is properly set-up then changes in the battery voltage will not affect the air/fuel
ratio.

The injector dead-time table allows the dead-time for different battery voltages to be entered. 
The values represent the dead-time in milliseconds.  These should increase with falling
system voltage.

Injector dead-time for a particular set of injectors can be determined using a flow bench or on
a running engine.  

To determine the injector dead-time using a flow bench, the injectors need to be operated at
the intended operating pressure (normally three bar) and at a constant duty cycle as well as a
set voltage.  Vary the supply voltage to the injector and measure minimum pulse width at
which the injectors will flow for a particular voltage.  This is the required dead-time for that
injector at that tested voltage. 

To determine injector dead-time on a running engine, with the engine fully warmed and
operating at stable air/fuel ratios (a very precise AFR meter is required – a narrow band O2
sensor will not suffice), electrical drain needs to be applied to the system; the preferred
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method is disconnecting the alternator main fuse.  Battery load testers are also useful here
too.

Watching the air fuel ratios change while the battery voltage drops, the dead-time table can
be trimmed to maintain the same stable air/fuel ratio.  Injector dead-time can be viewed as a
row graph.  A smooth curve needs to be maintained at all times.

NOTE: any change to the fuel pressure or injectors will require a recalibration of the injector
dead-times.

Master

Master should be set so that the numbers in the middle of the fuel table end up around a
value of 50.  This is to allow sufficient span of the numbers in the main fuel table.
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8 Pin Functions

A list of pin functions is provided, this is useful when configuring your ECU through Vi-PEC
Tuning Software.

8.1 Nissan Silvia/180SX/200SX SR Short Header

S15 S14/N14 Distributed S14 MultiCoil S13

Auxiliary Outputs

Aux 1 Engine Fan Engine Fan Engine Fan Engine Fan

Aux 2 Tacho Tacho Tacho Tacho

Aux 3 A/C Clutch A/C Clutch A/C Clutch A/C Clutch

Aux 4 CE Lamp CE Lamp CE Lamp CE Lamp

Aux 5 Fuel Pump Relay * Fuel Pump Relay* - Fuel Pump Relay

Aux 6 - VVL Cam Lift (SR16VE) Wastegate Solenoid EGR

Aux 7 Oxy Heater Oxy Heater / Wastegate

Solenoid

Oxy Heater Wastegate Solenoid

Aux 8 VTC Cam / Purge

Solenoid

Purge Solenoid VTC Cam Solenoid N/C

Aux – Injection Outputs

Inj 5 Purge Solenoid / VTC

Cam Solenoid

- EGR Solenoid Fuel Pump Control

Inj 6 Fuel Pump Relay * Fuel Pump Relay* / VVL

Cam Lift Solenoid

(SR16VE)

Fuel Pump Relay AC / Clutch

Inj 7 ISC Solenoid ISC Solenoid ISC Solenoid ISC Solenoid

Inj 8 Wastegate Solenoid - - -

Analog Channels

An Volt 1 Oxy Signal Oxy Signal Oxy Signal Oxy Signal

An Volt 2 TPS (Main) TPS (Main) TPS (Main) TPS (Main)

An Volt 3 Int. MAP Sensor Int. MAP Sensor Int. MAP Sensor Int. MAP Sensor

An Volt 4 AFM Signal AFM Signal AFM Signal AFM Signal

An Volt 5 Expansion Connector Expansion Connector Expansion

Connector

Expansion Connector

An Volt 6 Expansion Connector Expansion Connector Expansion

Connector

Expansion Connector

An Temp 1 ECT ECT ECT ECT

An Temp 2 Header Pin 15 Header Pin 15 Header Pin 15 Header Pin 15

An Temp 3 Expansion Connector Expansion Connector Expansion

Connector

Expansion Connector

Digital Inputs

DI 1 A/C In A/C In A/C In A/C In
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S15 S14/N14 Distributed S14 MultiCoil S13

DI 2 Start Signal Start Signal Start Signal Start Signal

DI 3 Pow er Steer Sw itch Pow er Steer Sw itch Pow er Steer

Sw itch

Pow er Steer Sw itch

DI 4 Neutral Sw itch Neutral Sw itch Neutral Sw itch Neutral Sw itch

DI 5 Vehicle Speed Vehicle Speed Vehicle Speed Vehicle Speed

DI 6 Expansion Connector Expansion Connector Expansion

Connector

Expansion Connector

* Fuel Pump Relay could be on Aux 5 OR Inj 6
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9 Pinouts

Pin information is provided to assist when troubleshooting. All pinouts are looking into the
ECU (wire side).

9.1 Nissan Silvia/180SX/200SX SR Short Header

1994 - 2002 (S13 Type-X, S14 and S15)

Pin ECU Function Pin ECU Function

101 Injector 1 20 An Volt 2

102 Aux 6 24 Aux 4

103 Injector 3 25 Ignition 4 / Aux – Ign 4

104 Aux 5 32 DI 5

105 Aux – Inj 5 34 DI 2

106 Aux – Inj 6 35 DI 4

110 Injector 2 41 DI 1

111 Aux 7 43 DI 3

39 Ground 38 +14V ECCS Relay

112 Injector 4

113 Aux – Inj 7 Other Connections

114 Aux 8 Internal MAP An Volt 3

115 Aux – Inj 8 Expansion 1 Signal Ground

1 Ignition 1 Expansion 2 +5V Out

2 Aux 2 Expansion 3 DI 6

3 Ignition 2 / Aux – Ign 2 Expansion 4 -

5 Ignition 3 / Aux – Ign 3 Expansion 5 An Volt 5

9 Aux 1 Expansion 6 An Volt 6

10 Aux 1 Expansion 7 An Temp 3

11 Aux 3 Expansion 8 -

15 An Temp 2

16 An Volt 4

18 An Temp 1

19 An Volt 1
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Pinout for: 1991 - 1993 (S13)

Pin ECU Function Pin ECU Function

101 Injector 1 20 An Volt 2

102 Aux 6 24 Aux 4

103 Injector 3 25 Aux 1

104 Aux 5 32 DI 5

105 Aux – Inj 5 34 DI 2

106 Aux – Inj 6 35 DI 4

110 Injector 2 41 DI 1

111 Aux 7 43 DI 3

39 Ground 38 +14V ECCS Relay

112 Injector 4

113 Aux – Inj 7 Other Connections

114 Aux 8 Internal MAP An Volt 3

115 Aux – Inj 8 Expansion 1 Signal Ground

1 Aux 2 Expansion 2 +5V Out

2 Ignition 1 Expansion 3 DI 6

3 Ignition 2 / Aux – Ign 2 Expansion 4 -

8 Ignition 3 / Aux – Ign 3 Expansion 5 An Volt 5

9 Ignition 4 / Aux – Ign 4 Expansion 6 An Volt 6

11 Aux 3 Expansion 7 An Temp 3

15 An Temp 2 Expansion 8 -

16 An Volt 4

18 An Temp 1

19 An Volt 1
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10 Known Issues

All plug-in ECUs are fully tested on a range of relevant vehicles, although there are often
variations that have not been tested. For this reason issues can arise. Please contact your
nearest Vi-PEC dealer when suspecting a compatibility issue.

10.1 Nissan Silvia/180SX/200SX SR Short Header

There are currently no known issues.
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